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Question 1
Question Type: MultipleChoice

Which of the following options will you use to make all the changes made to the document visible inline in the document?

Options: 
A- Sort comments

B- Track Changes

C- Comment

D- Balloons

Answer: 
D

Explanation: 
Balloons are used to display deletions, comments, formatting changes, and the content that has been moved. By default, balloons are

used to display all the changes that are made while reviewing a document. If you want to see all the changes inline, you can change



settings so that tracked changes and comments display in the desired way.

Answer option C is incorrect. Comment is used to let the creator know what other person thinks of the document.

Answer option B is incorrect. The Track Changes option is used to view all the changes done by the reviewer(s). Answer option A is

incorrect. It is not a valid option to make all the changes made to the document visible inline in the document.

Chapter: ADVANCED WORD PROCESSING

Objective: Collaborative Editing

Question 2
Question Type: MultipleChoice

Jasmine creates a presentation. She wants to start another presentation after completing the current presentation during the slide show.

Which of the following will she use to accomplish the task?

Options: 
A- Hyperlink



B- Reuse Slides

C- Action Buttons

D- SmartArt

Answer: 
A

Explanation: 
Hyperlinking is a process to introduce a dynamic textual environment by attaching links to the Uniform Resource Locator (URL). It is

used to link various elements of a slide to another slide. It can also be used to interconnect excel sheets, word document, or any other

presentation. A user can create a hyperlink to the following:

A slide in the same presentation.

A slide in a different presentation.

An e-mail address.

A page or file on the Web.

A new file.

Answer option B is incorrect. The Reuse Slides feature is used when a user selects a slide from a presentation and reuses it into another

presentation.



Answer option D is incorrect. SmartArt is a visual graphic used to represent the information effectively and efficiently. It is used to create

designer-quality illustrations. A user can increase the emphasis of information by adding SmartArt. Though a SmartArt graphics

audience of a presentation can understand and recall information better than a text, it is necessary to visualize what type and layout are

best for displaying data, and what a user wants to convey with a SmartArt graphic. A user can quickly convert slide text to a SmartArt

graphic. In addition, a user can add animation to a SmartArt graphic in Office PowerPoint 2010 presentations.

Answer option C is incorrect. The action buttons are the predefined buttons that are used to traverse quickly and efficiently in a

presentation. They are used for defining hyperlinked objects. The hyperlinked objects can be a Web page, a file, or a network location.

The action buttons are mostly used for self-executing presentations.

Chapter: PRESENTATION, ADVANCED - LEVEL

Objective: Multimedia

Question 3
Question Type: MultipleChoice

James works as a Database Designer for AccessSoft Inc. The company has a Windows Vista-based computer with Microsoft Office

2007 installed on it. The company uses Microsoft Office Access 2007 database named Sales. He has to link a text file to the Access

database. He clicks the office button and opens the text file. The file is displayed in the Link Text Wizard. What will happen when James

clicks the Finish button in the wizard?



Options: 
A- Data of the text file is appended to an existing table and gets affected if there is a change of data in the text file.

B- The data is copied into a new table and is not affected if there is a change of data in the text file.

C- A new database will be created and a linked table will be created in the database.

D- A linked table will be created in an existing database.

Answer: 
C

Explanation: 
When James opens a text file in Microsoft Access, a new database is created and a linked table is created in the new database after the

Finish button is clicked in the wizard. The database is created with the same name as that of the text file. The wizard provides an option

of renaming the table. The default name of the table is same as that of the text file.

Chapter: DATABASE, ADVANCED-LEVEL

Objective: Import, Export and Link data

Question 4



Question Type: MultipleChoice

Which of the following are the ways to create a new blank presentation?

Each correct answer represents a complete solution. Choose all that apply.

Options: 
A- Click New Slide in the Home tab and then select the Blank presentation option.

B- Right-click on the current presentation slide and click the New Slide option.

C- Press Ctrl+M to insert a new blank presentation.

D- Right-click on the first slide and click the New Slide option.

Answer: 
A, C, D

Explanation: 
Following are the ways to create a blank presentation:

Click New Slide in the Home tab and then select the Blank presentation option.



Right-click on the first slide and click the New Slide option.

Press Ctrl+M to insert a new blank presentation.

Answer option B is incorrect. It is not a correct way to create a new blank presentation.

Chapter: PRESENTATION, ADVANCED - LEVEL

Objective: Slides

Question 5
Question Type: MultipleChoice

Which of the following are the types of action queries?

Each correct answer represents a complete solution. Choose all that apply.

Options: 
A- Update



B- Delete

C- Insert

D- Append

Explanation:

An action query is used to update multiple records in one operation.

Following are the four types of action queries:

Delete queries: A delete query is used to delete records from one or more tables.

Update queries: An update query is used to modify fields. It is used to update a field with an expression or data from another table.

Append queries: An append query is used to add records from one or more tables to the end of one or more other tables.

Make-table queries: A make-table query is used to create a new table from all or part of the data in one or more tables.

Answer option C is incorrect. It is not a valid type of action query.

Answer: 
A, B, D

Explanation: 

Chapter: DATABASE, ADVANCED-LEVEL

Objective: Table Design



Question 6
Question Type: MultipleChoice

Which of the following properties binds the forms and reports to a source from which data is to be retrieved?

Options: 
A- ControlSource

B- RowSource

C- RecordSource

D- Can Grow

Explanation:

The RecordSource property belongs to the form and report objects. This property binds the object to a source from which data is to be

retrieved. This source can be a table or a query. When a form or a report is bound to a table or a query, the controls can be bound to a

column of the table through the ControlSource property.

Answer option D is incorrect. The Can Grow property allows a control to adjust its dimensions according to the contents present in the

control. A control grows vertically to adjust its contents so that all the contents can be displayed. The default value of the Can Grow

property is false.

Answer option A is incorrect. The ControlSource property bounds a control to a field of a table. If a control is bound to a field by using

this property, the control is known as a bound control. If the value of this property is blank, the control is known as an unbound control. If

the ControlSource property contains an expression, the control is known as a calculated control.

Answer option B is incorrect. The RowSource property belongs to the combo box and list box controls. When these controls are bound



to a column by the RowSource property, all the data of the column is displayed in the list box or the combo box.

Answer: 
C

Explanation: 

Chapter: DATABASE, ADVANCED-LEVEL

Objective: Query Design

Question 7
Question Type: MultipleChoice

You work as a Database Designer for Tech Perfect Inc. The company has a Windows Vista-based computer with Microsoft Office 2010

installed on it. The computer has two tables named Customers and Details created in Microsoft Access 2010. You need to retrieve some

selected information of customers for each state in which your company does business. Which of the following types of query will you

create to accomplish the task?



Options: 
A- Parameter query

B- Crosstab query

C- Select query

D- Action query

Explanation:

To accomplish the task, you will create a parameter query.

The different types of queries in Microsoft Access 2010 are as follows:

Select query: It retrieves and displays records in the Table window in Datasheet view.

Crosstab query: It calculates and restructures data for easier analysis.

Action query: It performs operations on the records that match specified criteria.

Parameter query: It allows a user to prompt for a specific information to use as selection criteria in the query.

Answer: 
A

Explanation: 

Chapter: DATABASE, ADVANCED-LEVEL

Objective: Query Design



Question 8
Question Type: MultipleChoice

You have created a database named Addresses by using Microsoft Access 2010. You want to maintain the uniqueness of rows in the

table. Which of the following integrities will you use to accomplish this task?

Options: 
A- Entity

B- Domain

C- Data

D- Referential

Explanation:

Entity integrity enforces the uniqueness of rows in a table. The uniqueness of rows can be enforced by the identifier column(s) through

indexes, UNIQUE constraints, PRIMARY KEY constraints, or IDENTITY properties.

Answer option D is incorrect. Referential integrity means that the foreign key in any referencing table must always refer to a valid row in

the referenced table. Referential integrity ensures that the relationship between two tables remains synchronized during updates and

deletes. For a foreign key to be valid, it must contain either the value NULL, or an existing key value from the primary or unique key

columns referenced by the foreign key. To enforce referential integrity, a foreign key column link to the primary key column should be



created in the related table.

Answer option C is incorrect. Data integrity is a mechanism that ensures that the data is not modified during transmission from source to

destination. This means that the data received at the destination should be identical as that sent from the source. In order to maintain

data integrity, the data values must be within a defined range and in the correct format. For example, the value of an employee's age

must be within the range of 20-60 years, which means that the age cannot be below 20 years and more than 60 years.

Answer option B is incorrect. Domain integrity enforces data validity by restricting the data type, valid values (using CHECK constraints

and rules), and range of possible values (using FOREIGN KEY constraints) for columns in a table.

Answer: 
A

Explanation: 

Chapter: DATABASE, ADVANCED-LEVEL

Objective: Table Design

Question 9
Question Type: MultipleChoice



Which of the following characteristics is the most important characteristic of a field that is elected as a primary key in a table?

Options: 
A- Simple datatype

B- Unique

C- Easily remembered

D- Small in size

Answer: 
B

Explanation: 
A table usually has a column or combination of columns whose values uniquely identify each row in the table. This column (or columns)

is called the primary key. Primary key ensures that no duplicate or null values are entered in the column (or columns) defined as primary

key columns. This enforces integrity of the table. A primary key can be created by defining a primary key constraint while creating or

altering a table. A table can have only one primary key constraint. As primary key constraints ensure uniqueness, they are often defined

by using an identity column.

Answer option D is incorrect. It is not important to consider the size of a primary key.



Answer option C is incorrect. For using a database, it is not necessary to remember record keys.

Answer option A is incorrect. A simple datatype is helpful in the key indexing, but it is not a primary characteristic.

Chapter: DATABASE, ADVANCED-LEVEL

Objective: Table Design

Question 10
Question Type: MultipleChoice

You work as an Office Assistant for Company Inc. You are creating a presentation in PowerPoint 2010. You want to add a Unicode (hex)

symbol as a bullet for main points. You have clicked the Bullets drop-down list and selected the Bullets and Numbering option. Which of

the following steps will you take next to accomplish the task?

Options: 
A- Click on the Bulleted tab and click the Picture button.

B- Click on the Bulleted tab and click the Customize button.

C- Click on the Numbered tab and click the Start at spin button.



D- Click on the Numbered tab and click the Picture button.

Explanation:

The Customize button is used to add bullets of a Unicode (hex) symbol. Take the following steps to use a symbol as a bulleted list icon:

Select a text.

Click the Bullets icon under the Paragraph group.

The Bullets and Numbering gallery appears. Select the Bullets and Numbering option.

The Bullets and Numbering dialog box appears. Click the Customize button.



The Symbol dialog box appears. Select a symbol, and click the OK button.

Answer option A is incorrect. The Picture button is used to add a picture bullet.

Answer option D is incorrect. The Numbered tab does not contain any Picture button.

Answer option C is incorrect. The Start at spin button is used to specify the starting number of a bullet.



Chapter: PRESENTATION, ADVANCED - LEVEL

Objective: Slides

Answer: 
B

Question 11
Question Type: MultipleChoice

Which of the following join types results in the multiplication of the number of rows from the left table with the number of rows from the

right table when it is used in an Access query?

Options: 
A- Outer join

B- Self join

C- Cross join

D- Inner join

Explanation:



When a cross join is used in a query, it results in the multiplication of the number of rows from the left table with the number of rows from

the right table.

Answer option D is incorrect. In an inner join, data in various columns are compared by using the comparison operators. It is also known

as equi-joins. The inner join returns only those rows that have an equal value.

Answer option A is incorrect. Outer joins are used to write a join that provides information about the mismatches or missing records. An

outer join finds matches just like as an inner join, but also identifies the mismatches. With a suitable WHERE clause, an outer join can

filter out matches to display only the mismatches.

Answer option B is incorrect. A self join is used to join a table with itself. In this case, a user will have to use two unique aliases for the

table.

Answer: 
C

Explanation: 

Chapter: DATABASE, ADVANCED-LEVEL

Objective: Query Design

Question 12
Question Type: MultipleChoice



Which of the following steps will you take to create a blank presentation?

Each correct answer represents a complete solution. Choose all that apply.

Options: 
A- Click the Home tab, select the New option, and then click the Blank Presentation option.

B- Double-click on the selected theme and it will appeare for the slide.

C- Click the Design tab and select a theme from the theme gallery.

D- Click the Presentations tab, select the New option, and then click the Blank Presentation option.

Answer: 
B, C

Explanation: 
Take the following steps to create a blank presentation:

Click the Design tab and select a theme from the theme gallery.

Answer options A and D are incorrect. These are not correct steps to create a blank presentation. Reference: ECDL/ICDL Exam Course

Manual, Contents: 'Blank presentation'



Chapter: PRESENTATION, ADVANCED - LEVEL

Objective: Managing Presentations
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